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Overview

Overview

Administrator Solution Tools provides a single dashboard to access multiple solutions, each
enabling OneStream administrators to perform their role effectively and efficiently. An overview

of each solution within Administrator Solution Tools is described below.

Business Rule Viewer

Allows Administrators to view current and historical business rules and member formulas. It also
provides a historical audit trail of all rules that have been added, edited or deleted.

Member Formula Builder

The Member Formula Builder lets you create and maintain dynamic and stored calculations with
step-by-step directions in a user-friendly interface that allows the user to avoid writing code. It
also provides the ability to see all formulas for a member in one place, including the scenario and

time-varying formulas.

Home Page Manager

Administrators can easily assign a default Home Page to a user or user group to display when

logging into OneStream.

Log Cleaner

Provides administrators with a simple interface to manage log files by allowing them to delete any

log type (Error, Logon or TaskLogs) in increments of 30 days up to 810 days.

Administrator Solution Tools Guide 1



Setup and Installation

Setup and Installation

This section contains important details related to the planning, configuring, and installation of

your solution. Before you install the solution, familiarize yourself with these details.

See also: OneStream Solution Modification Considerations

Dependencies

Component Description

OneStream Minimum OneStream Platform version required to install this version of

7.4.0 or later Administrator Solution Tools.

Select the Administrator Solution Tools

Development Location

Before beginning installation, decide whether to build Administrator Solution Tools directly in the
Production OneStream application or in a separate Development OneStream application. This

section provides some key considerations for each option.

Production OneStream Application: The primary advantage of building Administrator Solution
Tools in a Production application is that you will not have to migrate the resulting work from a
Development application. However, there are intrinsic risks when making design changes to an

application used in a Production capacity and not advised.
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Setup and Installation

NOTE: OneStream strongly recommends that you implement Administrator Solution
Tools in the Development environment with a fresh copy of the Production

application before starting work.

Development OneStream Application: As a best practice, use the Development OneStream

application to build Administrator Solution Tools.

Create the OneStream Development

Application
1. Ensure all the OneStream artifacts relating to Administrator Solution Tools such as

workflow profiles and entities are in the production application.

2. Copy your production OneStream application to your Development environment and
rename it. This development version is used for your Administrator Solution Tools

project.
Application Server Settings

You may need to edit the OneStream Application Server Configuration so users can create
and change data in the additional database tables. If other OneStream Solutions (such as

Specialty Planning) are already in the application, these adjustments may already exist.

See also: Solution Database Migration Advice

Configure the OneStream Application Server

Ensure that the security group settings include the users who will be working on and setting up

Administrator Solution Tools before proceeding.
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NOTE: Group settings are applicable to all OneStream Solutions, so keep the group
names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. Click Open Application Server Configuration File > Database.

3. Edit the following OneStream Database Server properties:

* Access Group for Ancillary Tables: Select a group that includes those who will access

records.
e Can Create Ancillary Tables: True
e Can Edit Ancillary Table Data: True

* Maintenance Group for Ancillary Tables: Select a group who will edit and maintain
tables.

* Table Creation Group for Ancillary Tables: Select a group who can create tables.

OneStream Database Server properties

=43

» Azure Database Connection Settings

» Connection String Settings

v General
Access Group for Ancillary Tables | DB_ANC_Access_Group |«—————|| Read Access
Allow Database Creation via Ul Twe
Can Create Ancillary Tables ‘ True
Can Edit Ancillary Table Data True
Database Provider Type SaqlServer
ls Extemal Database False
Maintenance Group for Ancilary Tables DB_ANC_Mai ._Group Read Access
Name OneStream Datahase Server
Table Creation Group for Ancillary Tables Everyone I
Use File Groups when Creating Databases True
Use Table Paritioning when Creating Databases True

4. Restart Internet Information Server.
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Install Administrator Solution Tools

1. Inthe OneStream Solution Exchange, go to OneStream Solutions and select the

Administrator Solution Toolstile.

O
(2€)
&/

Administrator Solution Tools

2. Onthe Administrator Solution Tools Solution page, select the appropriate OneStream

platform version from the Minimum Platform Version drop-down list.

3. Select the most recent version from the Solution Version drop-down list and then click

Download.
4. Loginto OneStream.
5. Onthe Application tab, click Tools > Load/Extract.
6. Onthe Load tab, locate the solution package using the Select File icons and click Open.
7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Set Up Administrator Solution Tools

The first time you run Administrator Solution Tools, a guided table setup process begins.

In OneStream, click Community Solution > Dashboards > Administrator Solution Tools >

Administrator Solution Tools.
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(oL LIGETCl  Application  System *
=+ Workflow -
F? Cube Views -

4 & Administrator Selution Tools

|= Administrator Solution Tools

Create Tables

1. Click Step 1: Create Tables.

This step may be necessary when upgrading even if tables are already present.
Administrator Solution Tools will not drop any tables that already exist but will modify

table structures and add any new ones if necessary.

[f XFW_AST ControlLists

2. When setup is complete, click Step 2: Launch Solution to open Administrator Solution

Tools.

Package Contents

The Dashboard Maintenance Unit provides the user interface for Administrator Solution Tools

and includes the required dashboard groups, components, data adapters, parameters and files.

XFW Administrator Solution Tools
This is the Dashboard Maintenance Unit that provides the user interface for the Administrator
Solution Tools solution. It includes the Dashboard Groups, Components, Data Adapters,

Parameters, and Files used to build the solution.
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Business Rules

The following business rules are included:

AST_ClearLogsForThreshold
This is an extensibility business rule for the Log Cleaner. This rule provides low impact of clearing
functions for all three major log types (Combined Error, User Logon, and Task Activity) within

OneStream.

AST_HelperQueries
This is a Dashboard Data Set business rule. This rule can look up lists of user groups and

dashboards.

AST_ParamHelper
This is a conditional parameter helper functions Dashboard XFBR String business rule. This rule
provides conditional parameter processing functions that allow a parameter value to be

interpreted and substituted with a different string.

AST_SolutionHelper
This is a Dashboard Extender business rule that provides various helper functions for the

Administrator Solution Tools solution.

AST_SolutionHelperBRV
Contains all code logic and change events for the Business Rule Viewer and Member Formula

Viewer.

AST_SolutionHelperCommon
Contains common code shared by all business rules, such as working with session state and

sorting functions.

AST_SolutionHelperHOM

Contains all code logic and change events for the Home Page Manager.
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AST_SolutionHelperLCR

Contains all code logic and change events for the Log Cleaner, including functions that

generate log analysis charts.

AST_SolutionHelperMFB

Contains all code logic and change events for the Member Formula Builder.
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Settings

Settings

. The Settings page contains the Global Options tab where you define options for

administration, member formulas and uninstalling.

Only an Administrator Solutions Tools Administrator can access the Settings page. Configure
the Administrator in Global Options, mentioned in this section and can see and make changes to
any Settings page and any solution configuration. They are referenced in this document as “AST

Solution Admin.”

Global Options

The Global Options page contains key properties that guide global Administrator Solution Tools

administration. Use this page to start configuring Administrator Solution Tools.

Only an Administrator Solution Tools administrator can access the Administrator Solution Tools
Settings page. Set the Administrator in Global Options. The Administrator can see and make

changes to any Settings page and any solution configuration.

I NOTE: Global option settings are retained during upgrades.
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Settings

ADMINISTRATOR SOLUTION TOOLS el (@
SETTINGS

Global Options |~ Security Roles

Uninstall

Manage Administrator Solution Tools: | Administrators M

Access Administrator Solution Tools: | Everyone M

Access Home Page Manager: Administrators
Access Business Rule Viewer: Administrators
Access Log Cleaner: | Administrators v

Access Member Formula Builder:  Administrators v

Member Formula Builder Settings

Preview Non-MFB Formulas: =

NOTE: These same rights apply to any OneStream System Administrator, referred to in
this document as the “OneStream Admin.” See the Design and Reference Guide section

on Security for more information.

Security Roles

Since security is governed at the global level, it is the assignment of the user group to the

Security Role that determines who will be Administrator Solution Tools Administrators globally.
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This tool kit is designed with administrators in mind. The default setting for all solutions is the
standard Administrators User Group, but this can be changed. Anyone in the Administrators User
Group is a System Administrator and, by default, can perform any of the same duties as any of
the individual solution admins. Therefore, System Administrators can always see and access all

solutions within Administrator Solution Tools.

Manage Administrator Solution Tools

Anyone assigned to this User Group is considered a super-user who can configure any aspect of
Administrator Solution Tools and are referred to as the Solution Administrator. This user will have
access to the Settings page to manage security set up for all tools within Administrator Solution
Tools. This user will not have access to any of the individual solutions unless they are part of that

solution’s access group.

Example: The Administrator Solution Tools administrator may have access to Manage
Administrator Solution Tools however they do not have access to Access Home Page
Manager. This was done to allow Administrators to hide unwanted solutions from their
Administrator Solution Tools Home Page. If allowing Administrator access to all Administrator
Solution Tools is desired, create an Administrator Solution Tool Administrator security group
located in System > Security > System Security Roles, and add each solution’s security access

to the Group Membership.

Access Administrator Solution Tools

This group can access the Administrator Solution Tools Home page. This security group
supersedes any of the ensuing security groups. Therefore, any user who needs to access
individual solutions within AST and is part of one, or many, of the groups below, must also be

included in this security group first to gain access.

Access Home Page Manager
This group can access the Home Page Manager solution and assign home pages to users. The
Administrator role is required to access and use the Home Page Manager solution. This includes

any user included in the Administrators User Group.
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Access Business Rule Viewer
This group can access the Business Rule Viewer and can view Business Rules or Member
Formulas. The Administrator role is required to access and use the Business Rule Viewer. The

Administrator role includes any user included in the Administrators User Group.

Access Log Cleaner

This group can access the Log Cleaner solution and execute the clear logs process.

Access Member Formula Builder

This group can access the Member Formula Builder.

Creating formulas is a metadata change. Inherently, belonging to this access group does not

inherently allow users to change metadata, such as the Formula property on an Account. Users in
this group must also be included in the ManageMetadata security role, found under Application>
Security Roles. Giving access to manage metadata has other system implications. Therefore it is

recommended to limit the number of uses within this access group:

) Security Roles _— w00 & B X

P H

Application Security Roles

AdministerApplication Administrators
AdministerDatabase Nobody
OpenApplication Everyone
ModifyData Everyone
ViewAllData Administrators
CreateAuditAttachments Administrators
CreateFootnoteAttachments Administrators
CertifyAndLockDescendants Administrators
UnlockAndUncertifyAncestors Administrators

PreservelmportData Administrators
RestorelmportData Administrators
UnlockWorkflowUnit Administrators
ViewSourceDataAudit Everyone

EncryptBusinessRules Administrators

pertie: Adn

ManageMetadata ! Everyone

Dashboard - Adn  Cubes - CashFlov  Database Security Roles "

If this User Group is not included in the group for ManageMetadata, select the dimension in
Dimension Library where edits are desired, select the Dimension Properties tab and ensure that

this group is included in the Maintenance Group for that individual dimension.
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Member Formula Builder Settings

Preview Non-Member Formula Builder Formula
The Preview Non- Member Formula Builder Formula check box is enabled by default, allowing

a user to see the formula and drill down tabs that indicate a member formula was created outside

of Member Formula Builder.

NOTE: This interface is read-only. You can enter data on the page, but it is not save.

Edit formulas in the Dimension Library.

Dimension Library

fFormula | orilloown |

‘Calculate the tumns using safe divide
Return api.Data GetDataCelll Divide(A#60999:02Top, A% 16999V ETrailingZMonthavg:0=Top)")

See also: The Member Formulas section in the Foundation Guides chapter of the Design and
Reference Guide.

If the Preview Non-Member Formula Builder Formulas check box in the Administrator Solution
Tools Global Settings is cleared, the formula and drill-down tabs do not display. Edit formulas in

the Dimension Library.
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Cimension Library

Uninstall

The Uninstall feature allows the Administrator Solution Tools User Interface or the entire solution
to be uninstalled. Note that if part of an upgrade, any modifications performed on standard

Administrator Solution Tools objects will be removed. There are two Uninstall options:

« Uninstall Ul removes Administrator Solution Tools, including related dashboards and
business rules but leaves the database and related tables in place. For some releases, this
step should be performed before accepting any new version of Administrator Solution
Tools since some of the Dashboards or other objects may have been modified.

Choose this option to update without removing the data tables. Check the Release Notes

to see if an overinstall is supported.

« Uninstall Full removes all the related data tables, all data, Administrator Solution Tools
Dashboards, and Business Rules.
Choose this option to remove Administrator Solution Tools or to perform an upgrade that is

so significant in its changes to the data tables that this method is required.

CAUTION: Uninstall procedures are irreversible
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Administrator Solution Tools
Dashboard

Access the Administrator Solution Tools dashboard by clicking Community Solution>
Dashboards > Administrator Solution Tools. Starting Administrator Solution Tools opens the
Home page. The icons that display are based on security roles specified in Global Options. Use
this page to use the Administrator Solution tools that you have permission to access. To return

to the Home page, select the Show Home Page icon in the top toolbar.

ADMINISTRATOR SOLUTION TOOLS 2
HOME

oo 4 @)
oo 4 g
— 2 & -

Business Rule Viewer Home Page Manager Log Cleaner Member Formula Builder
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View Business Rules and Member

Formulas

The Business Rule Viewer lets you view any business rule or member formula created in
OneStream.To launch the Business Rule Viewer, click the Business Rule Viewer icon on

the Administrator Solution Tools Home page.

Business Rules

A business rule is a VB.Net class that performs a function or set of functions in OneStream. Each
business rule is an independent object encapsulating VB.Net code. Business rules are created
using the Business Rule Editor in Application Tools. Any business rule created in OneStream can

be viewed in the Business Rule Viewer.
See also:

o The Business Rules section in the Foundation Guides chapter of the Design and Reference
Guide for information on business rule fundamentals, organization, framework, and other

details.

o The Business Rules section in the Application Tools chapter of the Design and Reference

Guide for details on using OneStream to design Business Rules.

o The OneStream API Overview Guide, OneStream API Details, and database documentation

from OneStream Solution for business rule engine details.
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View Business Rules and Member Formulas

Member Formulas

A member formula is assigned to a dimension members and runs in the Finance Engine during

cube processing.

Member formulas are created directly on a member in the Dimension Library or with the
Administration Solution Tools Member Formula Builder. Member formulas created in the Formula

Editor in the Dimension Library must be edited in the Dimension Library.
See also:

o Build Simple Member Formulas in OneStream

o The Member Formulas section of the Foundation Guides chapter of the Design and
Reference Guide for information on Member Formula fundamentals and using OneStream

to design Member Formulas.

Select a Business Rule or Member Formula

to View

The Business Rule Viewer lets you view business rules or member formulas side-by-side. It's
most useful for viewing two versions of the same business rule, member formula, or similar rules

or formulas.

Use the drop-down lists in the Business Rule Viewer's Business Rules and Member Formulas
pages to select the rules or formulas to view. The drop-downs lists are filters to help organize
and quickly search. Selecting a value in a drop-down list filter determines the available values in
the next drop-down list. For example, if you are searching for a member formula to view and
select Flow as the dimension type, only the dimensions belonging to Flow display in the

Dimensions drop-down lists.
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View Business Rules and Member Formulas

The following shows the Business Rule Viewer drop-down list boxes for business rules

and member formulas.

BUSINESS RULE VIEWER - BUSINESS RULES
Business Rule lype: Business Rule: Moditied Date (UTC): Business Rule Type: Business Rule: Modified Date (UTC): C
Show XML DashboardExtendier ~ || AST_SolutionHelperBRV ~|[12 May 2021 18:33:07:693 (.. ~ DashboardExtender +|| AST_SolutionHelperBRV »|| 30 Apr 2021 15:15:32:770

BUSINESS RULE VIEWER - MEMBER FORMULAS

Dimension Type Dimension Member Dimension Type: Dimension Member

+ | HoustonAccount - ash - Account - || HoustonAccount +|| EndCast - C
Scenario Type: Time: Modified Date (UTC) Scenario Type: Time Modified Date (UTC)

enaric v || Default Time ~ || 03 Oct 2018 16:45:36:807 (Curr... Default Scenario || Default Time || 11 Feb 2018 16:29:57:45

The left and right areas are connected, so when you select a value on the left, the Business Rule

Viewer automatically populates the same field on the right with the same value.

See also: Connected and Disconnected Viewing Panes for more information on how the

viewing area works.

When you select a value for Modified Date (UTC) on the left, the Business Rule Viewer displays
the rule or formula you want to view in the left textbox. It also selects and displays the next most
recent version (if one exists) in the right text box. If the next most recent version of the rule of
formula shows as deleted, the next most recent version displays on the right. The Business Rule
Viewer assumes that you want to view a selected rule's most recent version and the next most

recent version in the side-by-side viewing areas.

NOTE: If a business rule or member formula does not have an earlier version, No

previous business rule to display is dipslayed in the viewing area.

Connected and Disconnected Viewing Panes

When you select a business rule or formula to view, the left side shows the selected version
and the right side shows the next most recent version. The views are connected, so the left

and right side scroll together.
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If you change a drop-down list value on either side, the sides are no longer connected and

work independently. When the left and right sides are disconnected, you can use the filters

independently to view different business rules or member formulas.

NOTE: The sides scroll together even when viewing different business rules or

formulas.

The following image shows different business rules displayed in the left and right views of

the Business Rule Viewer.

ADMINISTRATOR SOLUTION TOOLS
BU VIEWER s

If Not String.IsNullOrWhiteSpace(brvFilter) Then
Select Case True
Case bruFilter XFEqualsignoreCase("BRType")
If position.XFContainsignareCase("left") Then
_astHelperCommon.SetSessionStateValue(si,
"IsEncryptedLeft’, "False”)
If duplicateFilters Then

_astHelperCommon AddOrUpdateDi , bl ypeRight ASTBRV", brvfilterValue)
End If
_astHelperCommon AddOrUpdateDictionary

(modifiedVars, "BusinessRuleTextLeft ASTBRV", String Empty)

Else
_astHelperCommon SetSessionStateValue(si,
“IsEncryptedRight”, “False”)
If duplicateFilters Then
_astHelperCommon.AddOrUpdateDi “bl_Busir ypeleft ASTBRV", brvfilterValue)

End If
_astHelperCommon.AddOrUpdateDictionary
(modifiedVars, "BusinessRuleTextRight_ASTBRV", String. Empty)
End If

" Main entry point for the AST SolutionHelper business rule.
** This function is called when <alling functions from the Server Task property on solution components.
" </summary>
<param name Session Information</param>

" <param name="globals"> </param>

" <param name="api"> </param>

" <param name="args">Dictionary of Key/Value pairs passed into the requested funtion from the Ul
(Parameters).</param>

** creturns>Returns the base Object as a dashboard task result object </returns>

" <remarks>Function calls from Ul components call this main function when accessing business rule
code. </remarks>

Public Function Main(ByVal si As Sessioninfo, ByVal globals As BRGlobals, ByVal api As Object, Byval args
As DashboardExtenderArgs) As Object

Try

Dim modifiedVars As New Dictionary(Of String, String)
Select Case args.FunctionType
Case DashboardExtenderFunctionType.LoadDashboard
* Get the solution code from the parameter

Dim solutionCode As String = args.NameValuePairs XFGetValue
("Solution”, "Nothing")
If (args FunctionName XFEqualsignoreCase.
(“OnLoadMainDashboard")) Then
If aras | oadDashboardTaskInfo.Reason =

Business Rule Type Business Rule. Modified Date (UTC): Business Rule Type: Business Rule: Modified Date (UTC):
Show XML DashboardExtender -| AST_SolutionHelperBRY ~| |12 May 2021 18:33:07:693 (..~ DashboardExtender || AST SolutionHelper ~||29 Apr 2021 19.4033797 ot
ese!
Imports System. Text .
pace OneSt i \der AST SolutionHelperBRV pace OneStream.B Rule.DashboardExtender.AST SolutionHelps
Public Class BusinessRuleViewer
* Create instance of AST_SolutionHelper.MainClass ' <summary>
Dim ReadOnly _astHelperCommon As New * Provides functions for code operations from dashboard components
OneStream BusinessRule DashboardExtender. AST_SolutionHelperCommon.ASTCammon " </summary>
" <remarks> </remarks>
" esummary> Public Class MainClass
" Function handles all on change events for the Business Rule Viewer filter changes.
" <fsummary> * Create the class level readonly instance fields
" <param name="si">Session Information</param> Dim ReadOnly _astHelperCommon As New
" <param name="args">Args passed in from the function call.</param> Onestream. DashboardExtender.AST Solut |perCommon. ASTCommon
" <returns >XFSelectionChangedTaskResult object</returns> Dim ReadOnly _astHelperBrv As New
Public  Function  BusinessRuleFilterOnChange(ByVal ~si As Sessioninfo, ByVal args As OneStream.Busi D 'der. AST_SolutionHelperBRV.BusinessRuleViewer
DashboardExtenderArgs) As XFSelectionChangedTaskResult Dim ReadOnly _astHelperMfb As New
Try OneStre D: \der.AST_SolutionHelperMFB.MemberFormulaBuilder
Dim selectionChangedTaskResult As New XFSelectionChangedTaskResult() Dim ReadOnly _astHelperHom As New
Dim modifiedVars As New Dictionary(Of String, String) Onestream. D. AST_SolutionHelperHOM HomePageManager
Dim position As String = args.NameValuePairs XF GetValue(*Position”, String.Empty) Dim ReadOnly _astHelperlcr As New
Dim duplicateFilters As Boolean = _astHelperC Onestream. D der AST_SolutionHelperLCR LogCleaner
"DuplicateFilters", "False") XFConvertToBool(True) Dim ReadOnly _astHelperSecurity As New
* Get the filter being changed Onestream. D AST Solu |perCommon. Security
Dim brvFilter As String = args.NameValuePairs XFGetValue(Filter", String Empty)
Dim brvfilterValue As String = args.NameValuePairs XFGetValue(*Value®, String Empty) " csummary>

Click Reset Filters to reconnect the left and right views. This clears the drop-down filters on

both sides, initiating the connection of the left and right views.

Administrator Solution Tools Guide
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BUSINESS RULE VIEWER - BUSINESS RULES
Business Rule Type: Business Rule: Modified Date (UTC): Business Rule Type: Business Rule: Modified Date (UTC) C

Show XML

View a Business Rule

1. Inthe Business Rule Type drop-down list to the left, select the type of the business rule to

view.

2. Inthe left Business Rule drop-down, select the business rule to view. Only rules belonging

to the specified rule type display..

3. In Modified Date (UTC), select the version of the business rule to view.

NOTE: Business rules that are encrypted include the text (encrypted) in the Modified
Date (UTC) value. Encrypted business rules do not display in the Business Rule Viewer.
When you select an encrypted business rule, the text Selected business rule is

encrypted displays in the viewing area.

See also: Business Rule Encryption (Decryption) in the Application Tools section of the

Design and Reference Guide for more information.

In the following example, the most recent version of the AST _SolutionHelperBRYV business Rrle

displays on the left, with the next most recent version of the same rule on the right.
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ADMINISTRATOR SOLUTION TOOLS

VIEWER

Business Rule Type: Business Rule: Modified Date (UTC):

Show XML DashboardExtender ~ || AST_SolutionHelperBRV || 30 Apr 2021 15:15:32:770 (..~

Show Fullscreen

Imports System

Imports System.Data

Imports System Collections

Imports System.Collections Generic
Imports System.Globalization
Imports OneStream Shared Common
Imports OneStream.Shared Wcf
Imports OneStream.Shared Database
Imports System Text

pace OneStream
Public Class BusinessRuleViewer
' Create instance of AST_SolutionHelper.MainClass.
Dim ReadOnly _astHelperCommon
OneStream Busi D AST_SolutionHelperCommon. ASTCommon

AST_SolutionHelperBRV

As

" csummary>
Function handles all on change events for the Business Rule Viewer filter changes.
" </summary>
" <param name="si">Session Information</param>
" <param name="args" >Args passed in from the function call.</param>
" <returns>XFSelectionChangedTaskResult object </returns>
Public  Function ilteronc si
D: As XFSelectionCl
Try

As ByVal args  As

Dim selectionC} As New XFSelectionCl )
Dim modifiedVars As New Dictionary(Of String, String)
Dim position As String = args.NameValuePairs XFGetValue(*Position”, String Empty)
Dim  duplicatefilters As Boolean = _astHelperCommon GetSessionStateValue(si,
"DuplicateFilters', "False") XFConvertToBool (True}

*Get the filter being changed
Dim brvFilter As String = args NameValuePairs XFGetValue(*Filter”, String.Empty)
Dim brvfilterValue As String = args.NameValuePairs XFGetValue(*Value", String.Empty)

If Not String IsNullOrWhiteSpace brvFilter) Then
Select Case True
Case brvFilter XFEqualsignoreCase("BRType")
If position. XFContainsignoreCase("left") Then
_astHelperCommon.SetSessionStateValue(si,
"IsEncryptedLeft”, "False")

If duplicateFilters Then

_astHelperCommon.AddOrUpdateDic

|

ypeRight ASTBRV", )

End If
_astHelperCommon AddOrUpdateDictionary

Business Rule Type:
DashboardExtender

Business Rule Madified Date (UTC):

|| AST_SolutionHelperBRV * || 23 Apr 2021 14:20:29:113 -

Show Fullscreen

Imports System

Imports System Data

Imports System Globalization

Imports OneStream Shared Common

Imports OneStream Shared Wcf

Imports OneStream Shared.Database

Imports System Text

OneStream BusinessRule.D:

Public Class BusinessRuleViewer

* Create instance of AST_SolutionHelper MainClass

AST_Sol Ipe

Dim ReadOnly _astHelperCommon As New
OneStream. D: AST _Sol {elperCommon.ASTCommon
* <summary>
*" Function handles all on change events for the Business Rule Viewer filter changes.
" </summary>
param name="si">Session Information </param>
param name="args">Args passed in from the function call.</param>
" <returns> XFSelectionChangedTaskResult object </retums>
Public ~ Function By RuleFilterOnCl si As ByVal args As
D gs) As XFSelectionCl

Try

Dim selectionChangedTaskResult As New XFSelectionChangedTaskResult()

Dim modifiedVars As New Dictionary(Of String, String)

Dim position As String = args.NameValuePairs XFGetValue("Position”, String.Empty)

Dim  duplicateFilters As Boolean = _astHelperCommon.GetSessionStateValue(si,
“DuplicateFilters”, “False").XFConvertToBool(True)

" Get the filter being changed
Dim brvFilter As String = args.NameValuePairs XFGetValue("Filter", String Empty)
Dim As String = arg irs. "Value", String Empty)

If Not String.IsNullOrWhiteSpace(brvFilter) Then
Select Case True
Case brvFilter XFEqualsignoreCase("BRType")
If position XFContainsignoreCase("left") Then
_astHelperCommon SetSessionStateValue(si,
“IsEncryptedLeft”, "False")
If duplicateFilters Then

_astHelperCommon. AddOrUpdateDictionar , "bl_BusinessR
End If
_astHelperCommon AddOrUpdateDictionary

TypeRight ASTBRV", brvfilterValue)

(modifiedVars, "BusinessRuleTextLeft_ASTBRV", String Empty)
Else

Reset

The left and right sides are connected and scroll together, making it easy to view them.

View Business Rule XML

By default, business rules do not show the XML code at the beginning and end of the rule.

You can display the XML code for selected rules by clicking Show XML in the desired view.

The Business Rule Viewer keeps the displayed rules connected if you show the XML code.
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ADMINISTRATOR SOLUTION TOOLS

5 B [0 H

Madified Date (UTC):
11 Feb 2018 16:14:52:770 (..~

Business Rule:
DBP_ToggleOff -

Business Rule Type:
Finance v

<businessRule businessRuleType="Finance" nam;
<accessGroup> Everyone </accessGroup>

DBP_ToggleOff'>

<isGlobal>false </isGlobal>
<referencedAssemblies />
<sourceCode> <![CDATA[Imports System

mports System Data

Imports System Data Common

Imports System.I0

Imports System Collections.Generic

Imports System Globalization

Imports System.Ling

Imports Microsoft VisualBasic

Imports System Windows Forms

Imports OneStream Shared. Common

Imports OneStream Shared.Wcf

Imports OneStream Shared Engine

Imports OneStream Shared.Database

Imports OneStream Stage.Engine

Imports OneStream Stage. Database

Imports OneStream Finance Engine

Imports OneStream Finance. Database

Namespace Onestream.BusinessRule Finance.DBP_ToggleOff
Public Class MainClass
Public Function Main(ByVal si As Sessioninfo, ByVal globals As BRGlobals, ByVal api As FinanceRulesApi,
ByVal args As FinanceRulesArgs) As Object
Try
Select Case api FunctionType
Case Is = FinanceFunctionType Calculate

BRApI.D: False,

Setli i
“DBP_ToggleSeedLogic’, *False*)

BRApI.D: Setli False,
"ALX_TeggleAllocLogic", "False")
Return ConditionalinputResultType. Default

End Select

Return Nothing
Catch ex As Exception
Throw ErrorHandiler.LogWrite(si, New XFException(si, ex)
End Try
End Function
End Class

Madified Date (UTC):

*[[ 10 Feb 2018 16:14:52440

Business Rule:
DBP_ToggleOff

Business Rule Typ:

Finance M

—
<businessRule businessRuleType="Finance" name="DBP_ToggleOff">
<accessGroup> Everyone </accessGroup>
1tenanceGroup>

<isGlobal > false </isGlobal >
<referencedAssemblies />

<sourceCode> <![CDATA[Imports System
I*rghh_mpm ystem Data

Imports System Data Common
Imports System.|0
Imports System.Collections.Generic
Imports System Globalization
Imports System.Ling
Imports Microsoft VisualBasic
Imports System.Windows Forms
Imports OneStream.Shared.Common
Imports OneStream.Shared.Wcf
Imports OneStream Shared Engine
Imports OneStream.Shared.Database
Imports OneStream.Stage.Engine
Namespace OneStream BusinessRule Finance DBP_ToggleOff

Public Class MainClass

Public Function Main(ByVal si As Sessioninfo, ByVal globals As BRGlobals, ByVal api As FinanceRulesApi,

ByVal args As FinanceRulesArgs) As Object

Select Case api.FunctionType
Case Is = FinanceFunctionType Calculate

BRApi.Dashboards Parameters.SetLiteralParameterValue(si,

False,

"“DBP_ToggleSeedLogic", "False")
BRApi. Dashboards.Parameters SetL iteralParameterValuesi,

"ALX_ToggleAllocLogi
Return ConditionalinputResultType Default
End Select

Return Nothing
Catch ex As Exception

Throw ErrorHandler LogWrite(si, New XFException(si, ex))
End Try

End Function
End Class
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Access the Business Rule Source

When viewing business rules, you may want to make edits to the rule itself. To do this, click Show
Business Rule Page J% . The Business Rule page displays in a separate tab. Use CTRL + A to

highlight the rule to copy and paste, then navigate to the business rule you want to edit.

(@ Business Rules - AST_SolutionHelperBRV

DIROHI® | vw D] P
¥ [ Finance i
@ Parser
Filter * G = 2
» i@ Connector = ol | oo G
" » args 1 =Imports System
» i@ Conditional Rule @arg ) 2 | Imports System.Data
- @ Derivative Rule > & BRApI 2 | Imports System.Collections .
i b Snippets 4 | Imports System.Collections.Generic
»[® Cube View Extender 8 snipp , | Imports System.Globalization
» @ Dashboard Data Set 6 | Imports OneStream.Shared.Common
7 | Imports OneStream.Shared.Wcf
¥ ashboard Extender 5 | Imports OneStream.Shared.Database
T ACH Engine o | Imports System.Text
10
VX ACM _Validations 1 8 Onestr i le. ender.AST_SolutionHelperBRV
J% ADM _SolutionHelper 12 8 Public Class BusinessRuleviewer X
13 * Create instance of AST_SolutionHelper.MainClass
% ALX_SolutionHelper 14 Dim ReadOnly _astHelperCommon As New OneStream.BusinessRule.DashboardExtender.AST_SolutionHelperCommon.ASTCommon
& AST SolutionHelper =
16

<summary>

% AST_SolutionHelperBRV 17
+x AST_SolutionHelperCommon

Function handles all on change events for the Business Rule Viewer filter changes.

>Session Informationc/param>

/% AST SolutionHelperHOM » rgs">Args passed in from the function call.</params
21 “'* <returns>XFSelectionChangedTaskResult object</returns>
V% AST_SolutionHelperlCR n g Public Function BusinessRuleFilterOnChange(Byval si As SessionInfo, Byval args As DashboardextenderArgs) As XFSelectionChangedTaskResult
Y% AST_SolutionHelperMF8 » Try
2 Dim selectionChangedTaskResult As New XFSelectionChangedTaskResult()
/% ATB_ToolboxHelper - Dim modifiedVars As New Dictionary(0f String, String)
J% AWSe1_SolutionHelper % Dim position As String = args.NameValuePairs. XFGetValue("Position”, String.Empty)
5 BFRM_SolutionHel 27 Dim duplicateFilters As Boolean = _astHelperCommon.GetSessionstatevalue(si, "DuplicateFilters”, “False").XFConvertToBool(True)
* BFRM_SolutionHelper 2 ' Get the filter being changed
J% BMR_BudgetHelper » Dim bruFilter As String = args.NameValuePairs.XFGetValue("Filter”, String.Empty)
30 Dim brvfiltervalue As String = args.NameValuePairs.XFGetValue("Value", String.Empty)
X CAP_AssetHelper "
/& CAT ImportExportHelper 2 If Not String.TsNullorkhiteSpace(brvFilter) Then
i 3 Select Case True
/X CAT_ObjectModel 3 Case brvFilter.XFEqualsIgnereCase("BRType")
& CAT SolutionHelper 35 If position.XFContainsIgnoreCase("left") Then
- 3 _astHelperCommon. SetSessionStatevalue(si, "Iséncryptedieft”, "False")
/% CFM_SolutionHelper 7 T duplicatefilters Then
% CMR_SolutionHelper 38 _astHelperCommon . AddOrUpdateDictionary(modifiedvars, "bl_BusinessRuleTypeRight ASTBRV", brufilterValue)
- 19 End If
% ConsollournalRules a0 _astHelperCommon . AddorUpdateDictionary (modifiedvars, "BusinessRuleTextleft ASTBRV", String.Empty)
% CPP_ImpontExportHelper “ Else ) . R
a2 _astHelperCommon . SetSessionStatevalue(si, "IsEncryptedRight”, "False”)
/x CPP_SolutionHelper a3 If duplicateFilters Then
/R CSP.ImportéxportHelper aa _astHelperCommon . AddOrUpdateDictionary(modifiedvars, "bl_BusinessRuleTypeleft ASTBRV", bryfilterValue)
- a5 End If
V% CSP_SolutionHelper a6 _astHelperCommon. AddOrUpdateDictionary (modifiedvars, "BusinessRuleTextRight ASTBRV", String.Empty)
y a7 End If
VX CustomEvents CapitalPlanning a8 Case brvFilter.XFEqualsIgnoreCase("BRNane™)
% CustomEvents_CashPlanning 49 If position.XFContainsIgnorecase("left”) Then
s0 _astHelperCommon. SetSessionStateValue(si, "IsEncryptedieft”, "False")
X CustomEvents_ContractCompli . TF duplicaterilters Then
/% CustomEvents_PeoplePlanning 52 _astHelperCommon.AddOrUpdateDictionary(modifiedvars, "bl_BusinessRuleNameRight_ASTERV", brvfilterValue)
End If
% CustomEvents_ReportingComp «

Dashboard - Adn  Dimension Libra v

See also: Business Rules in the Application Tools chapter of the Design and Reference Guide.

View a Member Formula

Use the Member Formula viewer to view all member formulas.
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To view a formula in the Member Formula Viewer, filter using the drop-down list to the left

find formulas.

IMPORTANT: You can only access the Member Formula Viewer from the Business

Rule Viewer.

1. To access the Member Formula Viewer click Show Member Formula Viewer Page .

2.

In Dimension Type, make selections from these options for the member formula you want

to view:

Dimension Type: Select the dimension type for the member whose member formula
you want to view.
Dimension Types are used to group dimensions and includes User-Defined

dimensions. Only Dimension Types used display in the list.

Dimension: Select the Dimension containing the member whose formula you want
to view. Only dimensions belonging to the specified Dimension Type display in the

list.

Member: Select the member of the Member Formula you want to view.

Scenario Type: Select the Scenario Type associated with the member formula you
want to view. Select Default Scenario if the Member Formula applies to all scenario

types. A scenario type can contain multiple scenarios.

Time: This list contains the Time Profile for the selected Scenario Type. Select the

Time for the Scenario Type containing the Member Formula you want to view.

Modified Date (UTC): Select the version of the Member Formula you want to view.
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ADMINISTRATOR SOLUTION TOOLS R B|l@B ?
BUSINESS RULE VIEWER - MEMBER FORMULAS

Dimension Type: Dimension: Member: Dimension Type: Dimension: Member:
Account ~|[ HoustonAccounts ~|[ Endcash - Account - || Houstonaccounts ~|| ndcash - C
Scenario Type: Time: Modified Date (UTC): Scenario Type: Time: Maodified Date (UTC): Reset
Default Scenario +|| Defaut Time - Default Scenario v|| Default Time ~|| 11 Feb 2018 16:29:57:457
Show Fullscreen Show Fullscreen
If ((Not api Entity.HasChildren()) And (api.Cons.IsLocalCurrencyforEntity())) Then ‘api.Data.calculate(*A#EndCash:U3#Wk1 = A#BegCash + A#CashFlow")
apiData calculate("A#EndCash:O#Import:V#Periodic = A#BegCash:0#Top:V#Periodic - ‘api.Data calculate("A#EndCash:U3#Wk2 = A#BegCash:U3#Wk2 + A#EndCash:U3#Wk1 + A#CashFlow:U3#Wk2")
A#CashFlow:0#Top:V#Periodic - A#EndCash:0#Forms:V#Periodic") ‘api.Data.calculate("A#EndCash:U3#Wk3 = A#BegCash:U3#Wk3 + A#EndCash:U3#Wk2 + A#CashFlow:U3#Wk3")
End If ‘api.Data calculate("A#EndCash:U3#Wk4 = A#BegCash:U3#Wk4 + A#EndCash:U3#Wk3 + A#CashFlow:U3#Wk4")
‘api.Data.calculate(*A#EndCash:U3#Wk5_Month = A#BegCash:U3#Wk5_Month + A#EndCash:U3#Wkd4
A#CashFlow:U3#Wk5_Month")
api.Data.calculate("A#EndCash = A#BegCash + A#CashFlow")

The left and right sides are still connected, so the left and right sides scroll together, making it

easy to compare them.

Access the Member Formula Source

When viewing member information, you can edit the member formula.

You can access the Dimension Library while working in the Member Formula Viewer. Copy the
text using CTRL + A then click the Show Dimension Library Page % putton. The Dimension
Library displays in a separate tab, and displays the most recently accessed member properties. In

the Members tab of the Dimension Library, navigate to the member formula to edit.
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@ Dimension Library - HoustonAccounts, EndCash - Total Cash - Ei T @ B X

o mAE D XEH =0 &
¥ & Entity Dimensions Dimension Properties  Grid View
b 82 Scenario Dimensions
b @ Members Jationshi .
4B Account Dimensions Relationship Properties
»- @ Orphans .
4 RootAccountDim Enable UD2 Aggregation True
4 (@ Hierarchy
ACM_Metadatalmportf Enable UD3 Aggregation True
B None
CAPEX Enable UD4 Aggregation True
4 8B GAAP Account Structure
CashFlowForecastAcco Enable UDS Aggregation True
» &8 Income Statement
CFDrivers Enable UD6 Aggregation True
» Balance Sheet
CFModelAccounts ! : . Enable UD7 Aggregation True
atios
4 CorpAccounts 5 : Enable UDB Aggregation True
4 B statistics
HoustonAccounts B Vary By Cube Type
& NYAccounts. : B sales Drivers Flow Constraint Root
N¥AccountsBudl | IC Constraint Top
ExampleAccounts IC Member Filter
- % Driver Based Planning UD1 Constraint Root
FactorAccounts X
Newd ¥ % People Planning Drivers UD2 Constraint Root
ewDim
» % Capital Planning Drivers UD3 Constraint Root
ProfitabilityAccounts
» %3 Travel Planning Drivers UD4 Constraint Root
ProfitabilityDriversAcce
¥ % Cash Planning Drivers UDS Constraint Root
XFW_PCM_Accounts
4 3 Cash Planning Accounts UD6 Constraint Root
XPW_TXP_Accounts
»- % BegCash - Total Cash - Beg UD7 Constraint Root
P Merged Hierarchy For C
— ¥ &3 CashFlow - Total Cash Flow UDS Constraint Root
» = Flow Dimensions -
s % EndCash - Total Cash - End B Vary By Scenario Type
UD1 Dimensions
2' » B Flash Workflow Channel Standard
» 22 uD2 Di 5
mensions ¥ 1 Cash Flow B Vary By Scenario Type And Time
» 2 UD3 Dimensions
’ : » B Alloc Account Structure General
UD4 Dimensions
J - P B ElseGAAP In Use True
UDS Dimensions i Entit
= : b B IFRS Account Structure Formula If ((Not api Entity. HasChildre ...
¥ 2 UDE Dimensions Formula For Calculation Drill Down Dim formuala As String = "A#En .
- P~ B SystemAccounts
¥ 7& UD7 Dimensions Adjustment Type Journals.
» & UDB8 Dimensions Text
Text 1
Text 2
Text 3
Text 4
Text 5
Text 6
Text7
Text 8 !

Dashboard - Adn  Business Rules

See Also: Member Formulas in the Foundation Guides chapter of the Design and Reference
Guide.

View a Single Business Rule or Member

Formula

The text box sizes for the side-by-side view in the Business Rule viewer may cause linesin a
business rule or formula to display on two or more lines, making it difficult to read. Click Show

Fullscreento resolve this issue.
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ADMINISTRATOR SOLUTION TOOLS

BUSINESS RULE VIEWER - BUSINESS RULES

Business Rule Type: Business Rule: Moditied Date (UTC)
Show XML DashboardExtender -

Show Fullscreerg/®

Imports System

Imports System.Data

Imports System.Collections

Imports System.Collections.Generic
Imports System.Globalization
Imports OneStream.Shared.Common
Imports OneStream.Shared Wef
Imports OneStream.Shared Database
Imports System.Text

AST_SolutionHelperBRV ¥ || 12 May 2021 18:33:07:693 ( v

Namespace OneStream, BusinessRule.DashboardExtender. AST_SolutionHelperBRV
Public Class BusinessRuleViewer
' Create instance of AST_SolutionHelper.MainClass
Dim ReadOnly _astHelperCommon As New OneStream.BusinessRule.DashboardExtender AST_SclutionHelperCommon. ASTCemmon

" <summary>

" Function handles all on change events for the Business Rule Viewer filter changes.
" </summary>

Toggling between Fullscreen view and the standard view does not disconnect the left and right

side filter values. For example, if you reset the filter values and then switch back to the standard

view, the left and right sides scroll together.

Copy a Business Rule or Member Formula

You can copy any text in the left or right view. This is useful when you want to edit or replace a

business rule or member formula. Select the text, and then CTRL+C to copy. To select the entire
rule use CTRL+A.
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ADMINISTRATOR SOLUTION TOOLS

BUSINESS RULE VIEWER - BUSINESS RULES

Business Rule Type Business Rule: Modified Date (UTC)

Show XML Finance ~ || DBP_ToggleOff ~ |11 Feb 2018 16:14

52:770 -

Show Fullscreen

Imports System

Imports System Data

Imports Systemn.Data.Common
Imports System |0

Imports System Collections.Generic
Imports System.Globalization
Imports System Ling

Imports Microsoft VisualBasic
Imports System Windows.Forms
Imports OneStream.Shared.Common
Imports OneStream.Shared Wcf
Imports OneStream Shared.Engine
Imports OneStream.Shared.Database
Imports OneStream Stage.Engine
Imports OneStream Stage. Database
Imports OneStream.Finance.Engine
Imports OneStream Finance.Database

Namespace OneStream BusinessRule Finance.DBP_ToggleOff
Public Class MainClass

Public Function Main(ByVal si As Sessioninfo, ByVal globals As BRGlobals, ByVal api As FinanceRulesApi,
ByVal args As FinanceRulesArgs) As Object

Ty
Select Case api.FunctionType
Case Is = FinanceFunctionType. Calculate
SetLi Value(si, False,
"D ")
. Setli Value(si, False,

"ALX_ToggleAllocLogic”, “False”)
Return ConditionalinputResultType.Default
End Select

Return Nothing
Catch ex As Exception
Throw ErrorHandier.LogWrite(si, New XFException(si, ex))
End Try
End Function
End Class

End Namespace

Business Rule Type: Business Rule:

DBP._ ff -

Modified Date (UTC):

Finance - 11 Feb 2018 16:14:52.770

Show Fullscreen

Imports System

Imports System. Data

Imports System. Data.Common
Imports System.I0

Imports System Collections Generic
Imports System.Globalization
Imports System Ling

Imports Microsoft.VisualBasic
Imports System Windows.Forms
Imports OneStream.Shared Common
Imports Cnestream Shared Wcf
Imports OnesStream Shared Engine.
Imports OneStream.Shared Database
Imports GneStream Stage Engine
Imports OneStream.Stage.Database
Imports OneStream Finance.Engine
Imports GneStream Finance Database

Namespace OneStream BusinessRule. Finance. DBP_ToggleOff
Public Class MainClass
Public Function Main(ByVal si As Sessioninfo, ByVal globals As BRGlobals, ByVal api As FinanceRulesApi,
ByVal args As FinanceRulesArgs) As Object
Try
Select Case api FunctionType
Case Is = FinanceFunctionType Calculate

BRApi.D: etli falue(si, False,

"DBP_ToggleSeedLogic”, "False")
BRAPI.D: ds|

rameters.Setl |

False,
"ALX_ToggleAllocLogic”, *False”)
Return ConditionallnputResultType Default
End Select

Return Nothing
Catch ex As Exception
Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
End Try
End Function
End Class
End Namespace

Viewing Business Rule and Member

Formula Change Histories

Use the Business Rule Viewer - Historical Viewer to determine when business rule or

formulas were updated. From the Business Rule Viewer, click Show History Page to

display the viewer and access the change histories.

Clicking the Show History Page icon while viewing business rules displays the Business Rule
history. Click Show History Page while viewing formulas to display their history. Historical data

displays in a grid, allowing you to group records using the grid capabilities.
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1. From View, select Business Rules or Member Formulas.

2.

In the Date Range field, select the number of days from today to display historical

records. For example, to display the last 30 days of changes, select 30 from the list.

TIP: The records listed in the grid change based on your selections.

ADMINISTRATOR SOLUTION TOOLS

BUSINESS RULE VIEWER - HISTORICAL VIEWER

@ [

View:

Business Rules

Business Rule Type

Date Range:
30 Days

Drag a column header and drop it here to group by that column

¥ Business Rule Name

-

¥ IsGlobal ¥ User

I View Rule |

Y Modified Date (UTC)

12 May 2021 18:33:07:787
12 May 2021 18:33:07:770
12 May 2021 18:33:07:723
12 May 2021 18:33:07:693

-

v

12 May 2021 18:33:07:660

DashboardStringFunction AST_ParamHelper False
DashboardExtender AST_SolutionHelperMFB False
DashboardExtender AST_SolutionHelperCommon False
DashboardExtender AST_SolutionHelperBRV False
l DashboardExtender AST_SolutionHelper False
DashboardDataSet AST_HelperQueries False
DashboardStringFunction TDM_ParamHelper False
DashboardExtender TDM _SolutionHelper False
- e e
Extender QSD_ApplicationSnanshot False

Dashboard - Adn ENER

12 May 2021 18:33:07:630
11 May 2021 12:12:10:393
11 May 2021 12:12:10:313

ey —— e

06 May 2021 11:50:17:577

3. Toview abusiness rule or member formula, select it in the grid and click the View button.

This lets you access details in the appropriate viewer.
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Build Simple Member Formulas

The Member Formula Builder lets you create basic member formulas. If you need a complex

t| formula, create it in the Dimension Library.

See also: The Member Formulas section in the Foundation Guides chapter of the Design and

Reference Guide .

To launch Member Formula Builder, click Member Formula Builder on the Administrator Solution

Tools Home page.

Before building a member formula, ensure the member exists and the Formula Type, either stored
or dynamic, is established in the member's properties settings. To select the formula type, click
Application> Dimensions, select the member, select Member Properties, and then select the

formula type in Settings.

B Settings
Account Type Asset
: Formula Type FormulaPass3 -
Allow Input True
Is Consolidated True (regardless of Formula Type)
Is IC Account False
Use Alternate Input Currency In Flow False

Plug Account

Input View For Adjustments Use Scenario Setting (Default)
No Data Zero View For Adjustments Use Scenario Setting (Default)
No Data Zero View For NenAdjustments Use Scenario Setting (Default)

Use FormulaPass1 - FormulaPass16 for stored formulas. Use DynamicCalc and

DynamicCalcTextInput for dynamic formulas.
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Formula Build Process

Perform these steps to build a member formula:
o Select the dimension, member, and account you want to create the member formula.
o Select Scenario Type and Time properties.

o Build the formula and add calculation filters.

Select the Member
Select the dimension from the drop-down and then select the member.

TIP: To access a known member, use the search bar at the top of the Select
Member pane to find the member or you can navigate through the hierarchy to find

the appropriate member.

1 Select Member

Dimension

Account v
Member
CFModelAccounts -
| De-precExp|
4 CFModel

4 NetOpProfit_cfm - Net Operating Profit after Tax (NOPAT
4 EBIT_cfm - Earnings Before Interest and Taxes (EBIT)

DeprecExp_cfm - Depreciation Expense

After you select a dimension, member, and account member for your formula, the other panes

of the Member Formula Builder appear and you can continue the formula build process.
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Select Properties

In the Select Properties pane, the Formula Type and Account Type labels show the formula or
account type assigned to a selected member. The Existing Formulas drop-down list shows
Scenario: (Default)|Time Period: (Default) and displays other existing formulas on a selected
member. If you select the default Scenario and Time formula, the Scenario Type and Time display

as (Default Scenario Type) and (Default Time) respectively.

2 Select Properties

Formula Type Account Type
Storad (FormulaPassd) Expense

Existing Formulas (2 Items)

Scenario: Forecast | Time Period: (Default)

Scenario: Model | Time Period: (Default)

Select the scenario and time to apply to the formula.

If there is already a formula associated with the member, you can preview the formula

before making any changes. Click Preview to display the existing formula.
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Formula Type
Stored (Not Used)

Scenario Type

(Default Scenario Type)

E# || C# || S# || T#
Time Variables
Expression

A#Testla

< Add Add >
4 Member
Comments

Formula

A#Testla= 7845

3 Build Formula

@ Formula Preview 0 ox

Existing Formulas (2 Items)

2 Select Properties 5 Add Calculation Filters
Account Type
Revenue A# ¥ | | A#[GAAPAccountStruc
Scenario: (Default) | Time Period: (Default) - i MBI F#[TotalBalance].Child
Time S— .
o# ~| | O#Elimination.Childre
* | (Default Time) hd
# * | | 1#Top.Descendantsinc

Member Formula | Drilldown Formula

‘MFB Formula

* This formula has been generated by Member Formula Builder.
* Changes made in the Dimension Library to this formula may result in the inability
* of Member Formula Builder to read/edit this formula.

If ((Not api.Entity.HasChildren()) And (api.Cons.IsLocalCurrencyforEntity())) Then

api.data.calculate("A#Test1a= RemoveZeros(78*45)","A#[GAAPAccountStructure] Descendants”, "F#
[TotalBalance].Children","O#Elimination.Childreninclusive”,"l#Top.Descendantsinclusive", "U1#EntityDefault.Children®,"U2#None Children”,"U3
#UD1Default Descendantsinclusive”,"U4#EntityDefault Children”,"U5#EntityDefault Childreninclusive”,"U6#UD1Default Descendants”,"U7#Ent
ityDefault.Childreninclusive”,"U8#UD1Default Base”)

end if

Close

Preview

Clear Al

You cannot edit a formula if it was created outside of the Member Formula Builder. Users with

the Administrator role can edit formulas created outside of the Member Formula Builder in the

Dimension Library. Click Dimension Library to go to Member Properties, where you can edit the

formula.
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MEMBER FORMULA BUILDER

1 Select Member 2 Select Properties

Camerricn Formuta Type Accea Type
Aecount . Dynamic DynamicCalc
Exivting Formulas (1 Hem)
Membeer
- ‘Soenarice (Default) | Teme Pericd: (Defaulty
HoustonAccounts

(Defautt Scenario Type) -| [ (Befauit Time)

None
4 GAAP Account Struchure
¥ Income Statement
» Balance Sheet
4 Ratlos
4 Liquidity Ratios
CurRatio - Current Ratio
QikRatio - Quick Ratia
MNtWkCapRatio - Net Working Capital Ratie
o050
Profitability Analysis Ratios
Activity Analysis Raties
Capital Structure Analysis Ratios
Capital Market Analysis Ratios
b Statistics
* Flash
¥ Cash Flow
3
[

- r v ow

Alloc Account Structure Dimension Library

b IFRS dccount Structure

Build the Formula

Use the Build Formula section to create a simple member formula.

3 Build Formula

E# Cc# S# T# VE || A® F# || O# I# UT# || U2# || U3# || U4# || US#E || UG# || UT# || Us#

Time Variables Criteria Include Drilldown B RemoveZeros(

Is Base Entity and Local... Catculation Filters

Expression
AzDeprecExp_cfm Clear
< Add Add > = + - - [ ) [ 1

Dimension Icons

When you select a dimension icon, the Select Member dialog box appears so you can select

the appropriate member from the hierarchy.
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3  Build Formula

E# c# S# T# v# A# F# O# 1# U1# || U2# || U3# || U4# || US# || UG# || UT# || UB#

Time Variables Criteria Include Drilldown = RemoveZeros()

| |1sBase Entity and Local.. ~| |w cajculation Filters

Expression @ Sselect Member 0 ox
A#QikRatio Cube Houston iy
< Add Add > Dimension Type Account 1

Dimension HoustonAccounts 1 ]

4 Member

Comments labiply Scerch
) None
4 B GAAP Account Structure
» & Income Statement
Formula *- % Balance Sheet
A#QikRatio= 42 4 ' Ratios
4 B} Liquidity Ratios
5 CurRatio - Current Ratio
S aikRatio - Quick Ratio
&5 NtwkCapRatio - Net Working Capital Ratio
B DsSO - DSO

OK Cancel

Preview

Time Variables
These are sample Time Functions that can be used to create a formula and were included for
ease of formula creation. ltems selected from this dropdown are added to the Expression. For

more information on Time Functions, see the Design and Reference Guide.

Criteria
Defines the dimension to which the formula is applicable. If a criteria is selected from the
dropdown, it does not show in the Member Formula text box but can be seen in the Preview

dialog box.

Expression

This text box shows the selected dimensions or time functions selected. For stored formulas,
the expression automatically populates for the member selected in the Select Member pane to
help start the stored formula creation. Any text that is entered here can be cleared using the

Clear button.

Clear

The Clear button is used to clear the Expression text box.
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3 Build Formula

=3 c# S# T# VE || Ax FE || O I UT# || U2# || U3# || U4# || USE || Ubs || UT# || USx

Time Variables Criteria Include Drilldown B RemoveZeros()

# i v i .. T
T#PovPrior1 Is Base Entity and Local Calcutation Filters

Expression

T#PovPriorl:A2DeprecExp_cfm

Add
There are left and right Add buttons which determine whether to place the expression before
or after the Member Formula. Click the appropriate Add button to add the content currently in

the Expression text box to the specified place in the Member Formula.

Calculation Filters
Only appears for stored formulas. This option lets you build calculation filters based on
dimensions. Selecting this check box displays the Add Calculation Filters pane that lets you add

filters that are calculated only if certain criteria are met.
To add a calculation filter:

1. Under Build Formula, select the Calculation Filters check box to open the Add

Calculation Filters pane.

2. Inthe Add Calculation Filters pane, click on the desired dimension button. The Select

Member dialog box displays.
3. Use navigation in the Hierarchy and Search tabs to select a member to which the

calculation filter applies.

TIP: You can use the Select Member dialog box to select multiple members to

which the calculation filter applies.
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4. Click OK to close the Select Member dialog box and return to the Add Calculation Filters

pane. Selected members are added to the calculation filter.

5. Select the expansion from the drop-down next to the selected dimension.

Tels
ADMINISTRATOR SOLUTION TOOLS . O O
[uevses rormapmper |
1 Select Member 2 Select Properties 5 Add Calculation Filters
[ pR—— Jr—
Aacoount r Soned (Tormdabased) perie
[ TIewTa— Soenano: Forect | Time Pencdt (Default)
Forecant # [Defaut Time)
Nere 3 Build Formula
& Civiode
4 NOpProfitchm - et Operating Prodt atee Trx iR T s e ute | Base * UlegEae
ImsteeneTax_cim - Imcomnt thx expense oA
4 EBIT_cim - Eammings Belore Intenest and Taves (EBTT) WU T -
® EHTDA gim - EBITDA Oenr
AR et - AR
AP chn

GromFinedAsiets - Grom Fived Assets.

4 FCF - Fepe Cabiicm -

Depreckxp_ctm - Depreciation Expansa Caleulate deprecisbon expense for Manutacturing bsolibes

4 NaOpRrote chin - Net Opiating Broft ifter Taa (NG
IncomeTax cfm - Income tax expense

4 BHIT gt - Earmings Bafors Irteres and Tases (1B

Deprocxp cfm - Depreciation bxpense
b EBITEA g - ERTDA tintoms * SrECuN SRR hone Daorms
Depreckxp chm ¢ -

4 Member Formula - Deprecexp_cim

In the previous example, the formula first runs on the UD1 base members under the
Ui#Mfg.Base dimension. The calculation filter is added by selecting the Ul# icon, then selecting
the member from the Select Member dialog. The appropriate expansion is added by selecting

from the drop-down.

Criteria defined in the text boxes are automatically saved and are part of the formula creation.

You can see the calculation filters as part of your formula by clicking Preview.
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(1) Formula Preview

Member Formula | Drilldown Formula .

"MFB Formula

* This formula has been generated by Member Formula Builder.

* Changes made in the Dimension Library to this formula may result in the inability
* of Member Formula Builder to read/edit this formula.

" MFE Comments

If ((Not api.Entity.HasChildren() And (api.Cons.isLocalCurrencyforEntity()) Then

api.data.calculate("SEPOV:V#PeriodicA#DeprecExp_cfm:F#None:0sNone= RemoveZeros
(S2POV:VEPeriodicA®GrossFixedAssets-F2EndBalance:0#Forms*S#POV:V#Periodic:A¥ DeprecWeight:F#None:O=Forms) ™™ "=, " "U1#Mfg.Base™ ™, =, *=,"","=," ")
end if

Comments
Use this to include a description for the formula. When you preview the formula, you can also

review the comments.

Include Drilldown
Selecting this check box allows drilldowns on the field for which the formula is being created.
This also allows you to edit the drilldown formula, which displays in the Drilldown Formula tab of

the Formula Preview.
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3  Build Formula

E# || C# || S# T# V# || A# || F# || O# I# Ut# || U24# || U3# || U4# || US# || UG# || UT# || Ug#

Time Variables Criteria B |nclude Drilldownll ®  RemoveZeros()

7| |!sBase Entity and Local... | | cylcylation Filters

Expression
A#QikRatio Clear
< Add Add > = + - : / ( ) [ ]
4 WSS @D Formula Preview 0 ox
Member Formula || Drilldown Formula |
Comments
Jason MFB Formula
This formula has been generated by Member Formula Builder.
Changes made in the Dimension Library to this formula may result in the inability
of Member Formula Builder to read/edit this formula.
Formula || --m-mmmmmm e
A¥QikRatio= 4 f ((Not api Entity.HasChildren()) And (api.Cons.lsLocalCurrencyforEntity())) Then

Dim result As New Drill DownFormulaResult()
esult.Explanation = “Formula Definition: A#QikRatio= 42"

Return result

end if

Close

Preview

RemoveZeros()

The RemoveZeros() function can be used to evaluate a source data buffer and remove all zeros in

cells where the amount is zero whether or not it is flagged as a NoData cell. This functionis

important to use for performance purposes and therefore is enabled by default.

See also: The Design and Reference Guide for more information on the RemoveZeros() function.
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Add Formula Complexity

You can use the Formula Editor to add complexity to a formula originally created in Member
Formula Builder outside of the solution (such as creating multi-line rules). We recommend that
you remove the Member Formula Builder syntax from business rule. This prevents formula

creators from viewing and updating complex rules in the Member Formula Builder.

* Caloulate deprecistion expense for Mamefacturing facilities

35 3F ({uet Bpd.EAETymasCRlAreny )y Aad (01.CdnS. DILOCRLCUT PEAITERTRELESID}] Thes
Ap3.BER, CRLEULMLE] " SAPOV VIR Er LSd 10 I ARMEBrECT XD S I FENOS IOMDNES REROVEIEroS(SIPTVIVIPEr LS5 | ARGrOSSF LRrtASSETS IFBIRABRLANCE LR CrRS S ERDY  VEPEr SO0 1E L ARCERrETHES GNP mNone [ORFOrmS) ", "7, 0"
ena 1F

NOTE: After building a formula, return to the Dimension Library and click Compile on

the Formula Editor’s toolbar to ensure that the VB.NET syntax is correct.

(@D Formula Editor - [EndCash] [

¢+ 12 217 8l[4]

» api . .
@ ap @ Extensible Finance
P @ args
b & BRApI The formula was compiled successfully.
P @ Snippets

OK

oK Cancel
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Manage Home Pages for Users

The Home Page Manager page allows Administrators to assign users or user groups to a
default Home Page that displays when you log into OneStream. To launch Home Page

Manager, select the icon on the Adminstrator Solution Tools home page.

The Home Page Manager lets you assign a default page to any user or user group. By default,
only users in the Administrators User Group can access the Home Page Manager, and only

Administrators can change this setting.

Users and User Groups are part of system security and are defined in OneStream.

See also: System Security Users and Groups in the System Administration chapter of the
OneStream Design and Reference Guide for more information about creating users and user

groups.
The Home Page Manager includes the following:

o A User/User Groups pane where you indicate if you are making an assignment for a single

user or all users belonging to a specified user group.

« The Select Home Page pane, where you select the home page and assign it to the user or

user group.

o The Home Page Viewer pane shows the currently assigned home page for a user (if any) in
the Current tab, and a Preview tab that displays the currently selected home page. You
can easily switch between these tabs to see current user home page assignments and

preview other home pages to assign.
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ADMINISTRATOR SOLUTION TOOLS 1 2z

® User  Group

Administrator

Clear

Select Home Page

0_ActivityAnalysisChart OSDC
0_ActivityAnalysisMainChart_ OSDC
0_Analysis ASTLCRA

0_Analyze SAM

0_AppCopy_CAT
0_ChartData_LTPH
0_CloseSchedule CMRSCH
0_ContentFrame_ASTMFB
0_CopyRule_SAM
0_CopyRuleSet_SAM

0_CreateDefinition_SAM

Current | Preview
valuatior

valuation Date

2021-05-10_ ~

Daily Concurrency

Logon_Windows Logon_Silverlight B Logon_Studio [ Logon_Excel
.

2021-04-25

2021-04-26

2021-04-27

2021-04-28

2021-04-29

2021-04-30

2021-05-01

2021-05-02

2021-05-03

2021-05-04

2021-05-05

2021-05-06

2021-05-07

2021-05-08

2021-05-09

~| 12021-05-07 17:01:45 [New Snapshot] *

Logon_DataProvider [ Logon MVC -/ Logon_WPFServer [ Logon_Scheduler [ Logon_NativeAp;
.

0_Datasplitting_ TXMT
2021-05-10

0_DefinitionAdmin_SAM

10 Tasks 20 Tasks 30 Tasks 40 Tasks 50 Tasks 60 Tasks 70 Tasks

Assign a Home Page

1. Use the radio buttons on the upper left pane to set whether the home page assignment is
for a user or a user group.
If a user already has a home page assigned, the Current tab in the Home Page Viewer
pane shows the page assigned to the user. For both Users and User Groups, if a home

page has been previously assigned, use the Clear button to unassign the current home
page.

2. Inthe Select Home Page pane, select the home page you want to assign from the list. The

selected home page displays in the Home Page Viewer pane's Preview tab.
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3. Click Setto assign the home page to the selected user or user group. A message indicates
that the Home Page setting was updated. For user groups, the message also includes

the number of users in the group and information about any errors during processing.

(D Extensible Finance 0 ox

The Home Page setting has been updated for users in group: 3

‘UTM_Users'.

Home Page: EnabledFilter_SAR
Number of Users in Group: 4
Number of Updated Users: 4

OK

TIP: The User/User Group Selection and Select Home Page panes include a filter

that you can use to search for users, user groups, and home pages.

Change a Home Page Assighment

1. Select the user or user group whose home page assignment you want to change. The
currently assigned home page displays in the Current tab of the Home Page Viewer

pane.

2. Click Clear to clear the current home page assignment for the selected user.

3. Use the Select Home Page pane to navigate to the home page you want to assign, and

then click Set.
Assigning a Home Page: Example
Below is an example of how to set up Homepage Manager for a group or individual users.

NOTE: Your application may have different groups and dashboards since this is based

on our example application.
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1. Click User.

2. Type HDKin the first Text Filter search box for the user group/user selection to find all users

with HDK in the name. Click on the HDK_Admin user to select it.

3. Enter HDK in the Home Page Text Filter search box to find the dashboards with HDK in the
name. Select 2a_TicketAnalysis_HDKA.

4. The selected dashboard displays in the Preview pane and shows a sample of the selected
dashboard.

5. Click Set to save the selections for the user HDK_Admin.

ADMIMISTRATOR SOLUTION TOOLS " & 8

* User  Group P |
hee Ctagoey Filae:| A1
IR Open and Assigned Tickets: 2 High Priority: | Medium Priority: | Low Priority: ]
HOE_Usi2 Thckets by Status for [AN] * Sturbes by Prievity for [AN] .

1 14
Select Hame Page asd 1
PPy < | Loh |
20 51 TER1S |
2 Saepi TLES a1 1
20_Step1 UMCE | ol
2, Tckathnalyiia HOKA | |
28 TookarButinng BFEAL | |
20 ToolarBuniang_FERM ar 4 ]
22 ToobaButions SR | 1
2 TooRarButinns_ 50D 1
20 UnitiRanHAL_DEP . !
- - L e . o
A_Oyper B_dstagrand € Dried

A aopen D anigned [ C Clones

For this example, the Set Home Page results displays as shown in the following image.
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@ Extensible Finance

Set Home Page Results
User: HDK_Admin
Home Page: 2a_TicketAnalysis_HDKA

The Home Page setting has been updated for "HDK_Admin'.

OK

6. Login as HDK_Admin to confirm that the user can access the selected dashboard.
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Respond to Processing Errors

The Set Home Page Results message provides error information when an Administrator tries to
assign a dashboard to users who do not have access to the dashboard. Home Page Manager
processes the changes that are valid and notes those that could not be processed in Set Home
Page Results. Home Page Manager provides additional details for any other assignment errors

in the error log for review and resolution.

NOTE: When selecting a preview in Home Page Manager and using Internet Explorer,
solutions that contain multiple emmbedded dashboards may not display. This issue only

occurs in the OneStream browser version.
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Clean Unneeded Log Entries

To launch Log Cleaner, click Log Cleaner on the Administrator Solution Tools home

page.

Use the Log Cleaner to delete user log entries, error log entries or task activity log entries. The

Access Log Cleaner setting in the Global Options determines which users can access this feature.

Perform these steps to delete logs:

Select the type of logs you want to clear.

o Select the application and user for which you want to delete log records.

Select the number of days from today you want log records to be retained.

o Select Execute to clear selected logs.

Select Log Types to Clear

The first step to clear log files is to select the types of logs to be cleared. Use the fields in

the Types to Clear section of Log Cleaner to do this. Select values from the following:

I NOTE: All fields in this section are set to No by default.

User Logon Activity
Set to Yes to clear records of all users when they log on and off OneStream applications.

These records show who is logged on and when they log off for all applications.

Error Logs

Set to Yes to clear any logs from error processes, including errors written from business rules.
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Task Activity Logs

Set to Yes to clear logs for all running and completed tasks.

1 Types to Clear

User Logon Activity

No M
Error Logs
Yes v

Task Activity Logs

MNo A

When you change any of the default settings in the Types to Clear section, the Execute Clear
Logs Data Management Sequence section of the Log Cleaner appears. Click Execute to clear

logs based on the selected criteria.

Select Application and/or User

The second step in the log clearing process is to select specific users and applications whose

log entries you want cleared.

Log Cleaner allows administrators to select custom filtering to clear the Error Log based on

specific text.

Use the fields to clear logs based on application, user, and text in the log.

Application

Clear logs for a specific application or all applications.

User

Clear logs for an individual user or all users in the environment.
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Error Description Contains (optional)

Enter a text string from a log error to clear logs that use the string. The string must match exactly.

2 Application and/or User

Application

(Al M
User

AST_Admin v

Error Description Contains

ClearLogsB10_AST

Select Days to Retain

The third step in the log cleaning process is to determine how many days of error logs should be

retained after the current log clearing executes.

Days to Retain
Use this field to set the number of days error logs are retained after the current log clearing

executes.

Select a value between 30 and 810 days. For example, if set to 90, all qualified error records older

than 90 days are cleared.

3 Days to Retain

Days to Retain

a0 v
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Execute Clear Logs Data Management

To clear logs, select log clearing criteria and the number of days to retain log records, and then

click Execute.

The Log Cleaner displays cleaning tasks as they execute. If needed, click Cancel Task to stop

the log clean process. Click Close when cleaning completes.

@ Task Progress 0 ox

Task 26 of 27: ClearLogs060_AST

99% Complete

Execute Business Rule 'AST_ClearLogsForThreshold'.

Cancel Task

Close

Log Analysis Page

The Log Analysis page provides a graphical user interface to review OneStream logs. The page

includes the following tabs that provide details on OneStream logs

Log Size
This tab shows the size of each log table by type (in megabytes) in a pie chart. Log types that

display are:
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o Task Activity

Error Log
o Logon Activity

Logs from all other tables

Use the information to help determine which logs you want to clear. In the following graphic, the
All Other Tables log table contains the bulk of retained log entries, representing a potential

place to focus alog clearing process.

ser | Logs by Application | Logs by Date |

Logs

Log Table Size (MB}

I Task Activity B Error Log Logon Actiity I AN Other Tables

Logs by User

This tab contains a bar chart showing the users with the most retained log activity. Bars on the
chart are color-coded, so you can see details on the exact number of task activity, error log,
and logon records for each user. Use this chart to quickly see which users you may want to

focus on for your log clearing process.
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Logs by Application

This tab contains a bar chart showing log entries by log type for each application. Bars on the
chart are color-coded, so you can see details on the exact number of task activity, error log, and
logon records for each application. Use this chart to see the applications you may want to focus

on for your log clearing process.

Logs by Date
This tab contains a bar chart showing the number of log entries by log type based on the amount
of time the records have been retained. Bars on the chart are color-coded, so you can see details

on the exact number of task activity, error log, and logon records for each.

Use the dropdown to select a monthly, quarterly, semi-annual, or whole year retention period. Use

this chart to see retention periods with the most log entries of each type.
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Help and Miscellaneous

Information

Display Settings

OneStream Solutions frequently display multiple data elements for proper data entry and
analysis. We recommend you set your screen resolution to 1920 x 1080 to best render forms and
reports. Also, adjust the Windows System Display Text setting to 100% and do not apply custom

scaling options.

Package Contents & Naming Conventions

The package file name contains multiple identifiers that correspond with the platform. Renaming
any of the elements contained in a package is discouraged in order to preserve the integrity of

the naming conventions.

Example Package Name: AST_PV7.4.0_SV102_PackageContents.zip

Identifier Description

AST Solution ID

PV7.4.0 Minimum Platform version required to run solution
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Identifier Description

SV102 Solution version

PackageContents File name
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Solution Database Migration Advice

A development OneStream application is the safest method for building out a solution with
custom tables such as this one. The relationship between OneStream objects such as workflow
profiles and custom solution tables is that they point to the underlying identifier numbers and not
the object names as seen in the user interface. Prior to the solution configuration and to ensure
the identifiers match within the development and production applications, the development
application should be a recent copy of the production application. After the development
application is created, install the solution and begin design. The following process below will help

migrate the solution tables properly.
See also: Managing a OneStream Environment in the Design and Reference Guide.

1. Inthe production OneStream application, install the solution and create the data tables.

See Configure the OneStream Application Server for Database Server Connection settings

and installation details.

2. Datatables are created in the OneStream Development application during the solution
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to

the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator

should run the migration assistant.

IMPORTANT: This process may overwrite existing table data in the production

application database if data already exists.
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OneStream Solution Modification

Considerations

A few cautions and considerations regarding modification of OneStream Solutions:

« Major changes to business rules or custom tables within a OneStream Solution will not be
supported through normal channels as the resulting solution is significantly different from

the core solution.

« If changes are made to any dashboard object or business rule, consider renaming it or
copying it to a new object first. This is important because if there is an upgrade to the
OneStream Solution in the future and the customer applies the upgrade, this will overlay
and wipe out the changes. This also applies when updating any of the standard reports

and dashboards.

« If modifications are made to a OneStream Solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a
logo or colors on a dashboard do not impact upgrades significantly. Making changes to
the custom database tables and business rules, which should be avoided, will make an

upgrade even more complicated.

Administrator Solution Tools Guide 56



	Overview
	Business Rule Viewer
	Member Formula Builder
	Home Page Manager
	Log Cleaner

	Setup and Installation
	Dependencies
	Select the Administrator Solution Tools Development Location
	Create the OneStream Development Application
	Application Server Settings
	Configure the OneStream Application Server

	Install Administrator Solution Tools
	Set Up Administrator Solution Tools
	Create Tables
	Package Contents
	Business Rules


	Settings
	Global Options
	Security Roles
	Member Formula Builder Settings

	Uninstall

	Administrator Solution Tools Dashboard
	View Business Rules and Member Formulas
	Business Rules
	Member Formulas
	Select a Business Rule or Member Formula to View
	Connected and Disconnected Viewing Panes

	View a Business Rule
	View Business Rule XML
	Access the Business Rule Source

	View a Member Formula
	Access the Member Formula Source

	View a Single Business Rule or Member Formula
	Copy a Business Rule or Member Formula
	Viewing Business Rule and Member Formula Change Histories

	Build Simple Member Formulas
	Formula Build Process
	Select the Member
	Select Properties
	Build the Formula

	Add Formula Complexity

	Manage Home Pages for Users
	Assign a Home Page
	Change a Home Page Assignment
	Assigning a Home Page: Example
	Respond to Processing Errors

	Clean Unneeded Log Entries
	Select Log Types to Clear
	Select Application and/or User
	Select Days to Retain
	Execute Clear Logs Data Management
	Log Analysis Page

	Help and Miscellaneous Information
	Display Settings
	Package Contents & Naming Conventions
	Solution Database Migration Advice
	OneStream Solution Modification Considerations




